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1.0 Introduction 
 

A variety of pesticides are available for control of flying insects over large areas, typically as a public 

health vector control measure (i.e., mosquitos, biting midges, black flies). While using similar 

equipment as conventional pesticide applications, such as aircraft and ground vehicle sprays, these 

differ from conventional applications in that they are deployed over large geographic areas rather than 

specific targets (e.g., farms) and they utilize specialized, ultra-low volume (ULV), spray equipment to 

achieve their efficacy. 

 

Adulticides are chemicals that target the adult stage of flying insects via applications over large 

geographic areas using equipment settings that are different from conventional applications. 

Communities seeking to control the adult stages of flying insects will apply adulticides over specified 

large swaths of land using aircraft or ground vehicle sprayers. To achieve efficacy, they are applied as 

ULV sprays (i.e., small quantities of a pesticidal active ingredient in relation to the size of the area 

treated)1 with specifications for smaller droplet sizes (between 5 to 30 µm)2, higher release heights, 

and larger swath widths that are different from conventional applications. These application 

parameters are intended to ensure the spray stays aloft for a period of time, killing flying insects upon 

contact. This SOP provides procedural guidance to assess bystander exposure following adulticide 

application via ground (truck-mounted sprayer) and aircraft. Procedural guidance to assess 

occupational handler and occupational post-application exposure is covered by separate guidance and 

policy documents.3 

 

Larvicides are chemical or biological pesticides typically formulated as liquids, tablets, pellets, granules, 

and briquettes, applied directly to aquatic breeding areas to target flying insect larvae. While applied 

over large areas, application equipment settings such as droplet sizes and spray release height are 

similar to conventional pesticide applications; therefore, potential bystander exposures following these 

applications are captured by the standard spray drift assessment.4 Similar to adulticides, occupational 

handler and occupational post-application exposures from larvicides are covered by separate guidance 

and policy documents.  

 
 

 
1 https://www.epa.gov/mosquitocontrol/controlling-adult-mosquitoes 
2 It is generally accepted by the mosquito control industry that optimum droplet size for mosquito control is in the range of 
5-25 µm in diameter where 8 – 15 µm droplets are most effective. Insecticidal efficacy decreases rapidly for droplet sizes 
smaller than 5 and larger than 25 µm. Further information can be found at 
https://www.acq.osd.mil/eie/afpmb/docs/techguides/tg13.pdf 
3 2012 Standard Operating Procedures for Residential Pesticide Exposure Assessment: 
https://www.epa.gov/sites/default/files/2015-08/documents/usepa-opp-hed_residential_sops_oct2012.pdf; Occupational 
Pesticide Handler Exposure Data: https://www.epa.gov/pesticide-science-and-assessing-pesticide-risks/occupational-
pesticide-handler-exposure-data 
4 The Agency has also prepared a draft document on how to appropriately consider spray drift as a potential source of 
exposure in risk assessments for pesticides. The approach is outlined in the revised 2013 Residential Exposure Assessment 
Standard Operating Procedures Addenda 1: Consideration of Spray Drift, which can be found at 
https://www.regulations.gov in docket identification number EPA-HQ-OPP-2013-0676 

http://npic.orst.edu/pest/mosquito/mosqcides.html#larv
https://www.epa.gov/mosquitocontrol/controlling-adult-mosquitoes
https://www.acq.osd.mil/eie/afpmb/docs/techguides/tg13.pdf
https://www.epa.gov/sites/default/files/2015-08/documents/usepa-opp-hed_residential_sops_oct2012.pdf
https://www.epa.gov/pesticide-science-and-assessing-pesticide-risks/occupational-pesticide-handler-exposure-data
https://www.epa.gov/pesticide-science-and-assessing-pesticide-risks/occupational-pesticide-handler-exposure-data
https://www.regulations.gov/
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2.0 Ground-Based ULV Post-Application Assessment 
 

For ground-based ULV adulticide application via a truck mounted sprayer, the fraction of the amount 
applied that deposits on the ground after an application (Dep) is based on an EPA analysis of studies 
measuring deposition following ground-based ULV applications. An appropriate mechanistic model is 
not currently available for evaluating ground adulticide applications. Air concentrations in the 
breathing zone of potential bystanders are calculated using the standard well-mixed box (WMB) 
model. Section 2.1 describes the standard methods used to assess non-occupational post-application 
exposures from dermal and non-dietary ingestion contact with ground-deposited residues following 
ground-based ULV applications. Section 2.2 describes the methods used to assess non-occupational 
post-application inhalation exposures following ground-based ULV applications.  
 
2.1 Post-Application Dermal and Non-Dietary Ingestion Exposure Assessment 
 

Post-application exposures are expected to occur from activities on turf following ground-based ULV 
adulticide applications in residential areas. Dermal and non-dietary ingestion (hand-to-mouth) 
exposure pathways are expected to result from contact with residues deposited on turf. The standard 
methods used for estimating potential dermal and hand-to-mouth doses among adults and children 1 
to <2 years old are as described in the 2012 Residential SOPs: Treated Turf SOP as follow.5 
 
Post-application Dermal Exposure Algorithm – Physical Activities on Turf 
Exposure resulting from contacting previously treated turf while performing physical activities is 
calculated as shown below. Residential post-application exposure assessment must include calculation 
of exposure on the day of application. Therefore, though an assessment can present exposures for any 
day “t” following the application, it must include “day 0” exposure. 
 

E = TTRt * CF1 * TC * ET 
 
where: 
 
E = exposure (mg/day); 
TTRt = turf transferable residue on day t (μg/cm2); 
CF1 = weight unit conversion factor (0.001 mg/μg); 
TC = transfer coefficient (cm2/hr); and 
ET = exposure time (hr/day). 
 
If chemical-specific TTR data are available, then surface residues from the day of application should be 
used (assume that individuals could be exposed to residues immediately after application). However, if 
data are not available, then TTRt can be calculated using the following formula: 
 

TTRt= (AR * F * (1-FD)t * CF2 * CF3) * Dep 
 

 
5 Available: http://www.epa.gov/pesticide-science-and-assessing-pesticide-risks/standard-operating-procedures-
residential-pesticide 
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where: 
 
TTRt = turf transferable residue on day t (μg/cm2); 
AR = application rate (lbs ai/ft2 or lb ai/acre); 
F = fraction of ai as transferable residue following application (unitless); 
FD = fraction of residue that dissipates daily (unitless); 
t = post-application day on which exposure is being assessed; 
CF2 = weight unit conversion factor (4.54 x 108 μg/lb); 
CF3 = area unit conversion factor (1.08 x 10-3 ft2/ cm2 or 2.47 x 10-8 acre/cm2); and 
Dep = deposition fraction (0.052). 
 
Dermal absorbed doses are calculated as: 
 

 
BW

AFE
D

*
=    

 
where: 

D = dose (mg/kg-day); 
E = exposure (mg/day); 
AF = absorption factor (dermal); and 
BW = body weight (kg). 

 
Table 2.1.1: Turf (Physical Activities) -- Inputs for Residential Post-application Dermal Exposure Following Ground-
Based ULV Adulticide Applications 

Algorithm Notation 
Exposure Factor 

(units) 
Point Estimate(s) 

AR 
Application rate 

(mass active ingredient per unit area) 
[input] 

Dep 
Deposition Fraction (fraction of active ingredient applied 

deposited on residential turf) 
0.052 

F 
Fraction of AR (liquid formulation) as TTR following 
application (if chemical-specific data is unavailable) 

0.01 

FD 
Daily residue dissipation (if chemical-specific data is 

unavailable) 
(fraction) 

0.1 

TC 
Transfer Coefficient (Liquid 

Residue) (cm2/hr) 

Adults 180,000 

Children 1 < 2 years old 49,000 

ET 
Exposure Time 
(hours per day) 

Adults 1.5 

Children 1 < 2 years old 1.5 

BW 
Body Weight 

(kg) 

Adults 80 

Children 1 < 2 years old 11 

L/WP/WDG = Liquids/Wettable Powders/Water-dispersible Granules 

 
Post-application Hand-to-Mouth Exposure Algorithm– Physical Activities on Turf 
Exposure from hand-to-mouth activity is calculated as follows (based on the algorithm utilized in the 
SHEDS-Multimedia model): 
 

E = [HR * (FM * SAH) * (ET * N_Replen) * (1- (1- SE)(Freq_HtM/N-Replen))] 
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where: 
 
E = exposure (mg/day); 
HR = hand residue loading (mg/cm2); 
FM = fraction hand surface area mouthed / event (fraction/event); 
SAH = typical surface area of one hand (cm2); 
ET = exposure time (hr/day); 
N_Replen = number of replenishment intervals per hour (intervals/hour); 
SE = saliva extraction factor (i.e., mouthing removal efficiency); and 
Freq_HtM = number of hand-to-mouth contacts events per hour (events/hour). 
 
and 
 

 
2 * SA

DE * Fai
  HR

H

hands=   

 
where: 
 
HR = hand residue loading (mg/cm2); 
Faihands  = fraction ai on hands compared to total surface residue from dermal transfer coefficient study 
(unitless); 
DE = dermal exposure (mg); and 
SAH = typical surface area of one hand (cm2). 
 
Dose, normalized to body weight, is calculated as: 
 

 
BW

E
D =    

 
where: 

D = dose (mg/kg-day); 
E = exposure (mg/day); and 
BW = body weight (kg). 
 

Table 2.1.2: Turf (Physical Activities) – Inputs for Residential Post-application Hand-to-Mouth Exposure Following 
Ground-Based ULV Adulticide Applications 

Algorithm 
Notation 

Exposure Factor 
(units) 

Point Estimate(s) 

Faihands 
Fraction of ai on hands from dermal transfer coefficient 

study 
(unitless) 

0.06 

DE Dermal exposure (mg) Calculated 

SAH 
Typical surface area of one hand (cm2), children 1 < 2 

years old 
150 
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Table 2.1.2: Turf (Physical Activities) – Inputs for Residential Post-application Hand-to-Mouth Exposure Following 
Ground-Based ULV Adulticide Applications 

Algorithm 
Notation 

Exposure Factor 
(units) 

Point Estimate(s) 

HR Residue available on the hands (mg/cm2) Calculated via (DE * Faihands)/SAH 

FM 
Fraction hand surface area mouthed 

(fraction/event) 
0.127 

N_Replen 
Replenishment intervals per hour 

(intervals/hr) 
4 

ET 
Exposure time  

(hrs/day) 
1.5 

SE 
Saliva extraction factor 

(unitless) 
0.48 

Freq_HtM 
Hand-to-mouth events per hour 

(events/hr) 
13.9 

BW 
Body Weight 

(kg) 
Children 1 < 2 years old 11 

 
All algorithm inputs referenced in Tables 2.1.1 and 2.1.2 are defined in the 2012 SOPs: Treated Turf 
SOP (Section 3.2), except for the ground-based residue deposition fraction (Dep) input, described as 
follows.  
 
Ground-Based Residue Deposition Fraction (Dep) 
The potential for contact with settled residues following ground-based ULV applications is primarily 
determined based on the ground-based residue deposition fraction. Previously, the ground-based 
deposition fraction was informed by a 20136 analysis conducted by the Environmental Fate and Effects 
Division (EFED). The analysis reviewed eight published studies on ground-based ULV applications in 
which deposition was measured. The studies varied in collection media (i.e., grass clippings and 
coupons), distance from application or spray head (ranging from 8 to 500 meters), and chemical 
measured (i.e., fenthion, malathion, naled, and permethrin). Since the 2013 analysis, an additional 
ground-based deposition study was submitted and has been evaluated by EFED.7  The resulting 
malathion study deposition fraction data were incorporated with the data from the other eight 
deposition studies to result in an off-target deposition rate of 5.2 percent of the application rate 
(Deposition Fraction = 0.052). This deposition value is recommended to evaluate ground-based ULV 
applications (i.e., 5.2 percent of the target application rate deposits on turf). The 5.2% ground fraction 
is used in conjunction with the methods and inputs described in the 2012 Residential SOPs: Treated 
Turf SOP, for estimation of post-application exposures (dermal and incidental oral) which may occur 
from indirect deposition on the ground/turf following ground-based ULV adulticide application 
targeting adult flying insects. The deposition input is used to determine what fraction of the total 
ground-based ULV adulticide application rate is expected to deposit and be available on turf for 
transfer to the exposed individual. The nine ground-based deposition studies evaluated measured 
deposition at a variety of distances; therefore, the recommended deposition fraction has no 
relationship to distance from application site. Further, this value does not represent the fraction of the 
deposited residues which may transfer from the turf (as TTR) to the treated individual following 

 
6 C. Peck, D407817, 3/28/2013; Environmental Fate and Effects Division (EFED) Memo 
7 C. Peck. Malathion Deposition Study: Ground ULV Application. MRID 51048301: Anderson, L. and Bonds, J. 2020. 
Malathion Deposition Study: From Operational Ground ULV Applications. 3/19/2021. 
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application (F). The value, F, is the same as is recommended as an SOP default for liquid formulations, 
0.01 (1%) as shown in Table 2.1.1 above. If chemical-specific TTR data are available, these should be 
considered for use in place of the default Treated Turf SOP, F value.  
 
2.2  Post-Application Inhalation Exposure Assessment 
 

Post-application inhalation exposures are expected to occur while conducting outdoor activities 
following applications of ground-based ULV applications in residential areas. The potential for non-
occupational post-application exposures following a ground-based ULV adulticide application is 
determined by following the principles of the WMB model for determination of potential inhalation 
exposure8. The WMB model is used to model pesticide air concentrations within an enclosed, fixed 
volume (i.e., a box) over time. It incorporates several simplifying assumptions: fresh air (having no 
pesticide concentration) enters the box at a constant airflow rate; a turbulent internal airflow 
thoroughly mixes the fresh air with the pesticide-laden air resulting in a uniform pesticide air 
concentration within the box; and the perfectly mixed air exits the box at the same constant airflow 
rate (i.e., the inflow rate equals the outflow rate). Thus, the outdoor area where the adulticide is 
present is assumed to be in an enclosed box. Using the WMB model is conservative for estimation of 
exposures for a yard where dissipation in outdoor air is expected to be greater than the enclosed space 
that the WMB model depicts. The following describes the SOP standard WMB model methods used for 
estimating inhalation exposures following ground-based ULV adulticide applications: 
 
Post-application Inhalation Exposure Algorithm 
The following algorithm is used to determine post-application inhalation exposure to outdoor aerosol 
space sprays: 

 

 
Q

ARIR
E

*
=    

where: 
E = inhalation exposure (mg/day); 
IR  = inhalation rate (m3/hour); 
AR  = application rate (mg ai/day); and 
Q = airflow through the treated area (m3/hour). 

  
 
The airflow through the treated space can be calculated as follows: 
 
 Q = AV *CF1* CF2 * Across-section   
 
where: 

Q  = airflow through treated space (m3/hr); 
AV  = air velocity (m/s); 
CF1  = time unit conversion factor (60 seconds/1 minute); 

 
8 2012 Standard operating Procedures for Residential Pesticide Exposure Assessment – Section 5: Outdoor Fogging/ Misting 
Systems: https://www.epa.gov/sites/default/files/2015-08/documents/usepa-opp-hed_residential_sops_oct2012.pdf 
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CF2  = time unit conversion factor (60 minutes / hour); and 
Across-section  = cross-section of outdoor space treated (m2). 

 
Application rate can be calculated as follows: 
 
 AR = AR product * CF1  * CF2 * CF3 * Across-section   
 
where: 

AR  = application rate (mg ai/ day); 
AR product = application rate ULV adulticide (lbs ai/acre); 
CF1 = weight conversion factor (454 g/lb);  
CF2 = area conversion factor (1 acre/43560 ft2); 
CF3 = weight conversion factor (1000 mg/g); and 
Across-section = cross-section of outdoor space treated (400 ft2)9 

 
Absorbed inhalation dose normalized to body weight is calculated as: 
 

 
BW

AFE
D

*
=    

 
where: 

D = dose (mg/kg-day); 
E = exposure (mg/day); 
AF = absorption factor (inhalation); and 
BW = body weight (kg). 

 
Table 2.2.:  Ground-Based ULV Adulticide Application –Inputs for Residential Post-application Inhalation Exposure  

Algorithm 
Notation 

Exposure Factor 
(units) 

 
Point Estimate(s) 

AR 
Application rate 

(mg ai/ day) 
[input] 

Q 
Airflow through treated area 

(m3/hr) 
5,400 

V Volume of treated space (m3) 90 

ET 
Exposure time  

(hrs/day) 
1.5 

IR 
Inhalation rate 

(m3/hour) 
Adult 0.64 

Children (1 < 2 years old) 0.33 

BW 
Body Weight 

(kg) 
Adult 80 

Children (1 < 2 years old) 11 

 
 
 

 
9 Per the 2012 Standard Operating Procedures for Residential Pesticide Exposure Assessment – Section 5: Outdoor Fogging/ 
Misting Systems:  An outdoor living space with dimensions of 20 ft. x 20 ft. x 8 ft. (i.e., 400 ft2 ) is assumed when calculating 
airborne concentration levels and turf deposition. Across-section represents the cross-sectional area of the volume of 
treated space for this exposure scenario, with units m2. 



 

Page 10 of 37 
 

2.3 Inhalation Risk Quantification  
 

Non-occupational bystander inhalation risks from ground-based ULV applications can be estimated 
with these WMB-modeled adult and child air concentrations and the human equivalent concentrations 
(HECs) estimated by the toxicologist specific to the exposure scenario being assessed. The anticipated 
time spent outdoors on turf by adults and children is 1.5 hours on the day of application only (Section 
3; Treated Turf SOP) – there is no expectation that bystanders will be repeatedly exposed to airborne 
concentrations of adulticides over a period of many days or weeks. Ideally, the selected HEC should 
reflect this anticipated acute bystander inhalation exposure.10 Since appropriate acute toxicological 
inhalation data are rarely available and/or subchronic inhalation studies may not be available, it may 
be necessary to use an oral point of departure, which may require additional conversion of modeled air 
concentrations for comparison to oral points of departure. The risk assessor should work with their 
toxicologist to determine appropriate endpoints based on the toxicological profile of the active 
ingredient.  
  
Quantification of post-application inhalation margin of exposure (MOE) with use of an HEC is 
conducted by use of the following formula:  
 
MOE = Human Equivalent Concentration (mg/m3)/ Time Weighted Average Concentration (mg/m3) 
 

When an inhalation study is not available for the calculation of an HEC, non-occupational bystander 
inhalation risks from ground-based ULV applications can also be estimated with these WMB-modeled 
adult and child air concentrations and a point of departure (POD) selected from an oral study. 
Quantification of post-application inhalation MOE with use of an oral POD is conducted by use of the 
following formula:  
 
MOE = Oral POD (mg/kg/day)/ Absorbed Dose (mg/kg/day) 
 

3.0 Aerial ULV Post-Application Exposure Assessment: Using the AGDISP™ Model  
 

The potential non-occupational exposure following an aerial ULV adulticide application is determined 
using the AGDISPTM model. The AGDISPTM model was developed by the United States Department of 
Agriculture (USDA) Forest Service. It is a "first-principles" science-based model that predicts spray drift 
from application sites. AGDISPTM was designed to optimize agricultural spraying operations and has 
detailed algorithms for characterizing the release, dispersion, and deposition over and downwind of 

 
10 An acute inhalation study appropriate for this duration of exposure is rarely conducted. The active ingredient, naled, is an 
example where a “special” acute inhalation study was designed similar to a subchronic study and included more detailed 
evaluations of potential systemic and portal of entry (POE) effects following acute exposures. This “special” study was 
conducted for the express purpose of estimating acute inhalation risks on a single day for an anticipated duration of 2 
hours. For most active ingredients, an acute inhalation study of this type will not be available. Further, the acute inhalation 
6-pack guideline study is unlikely to be appropriate for assessing bystander exposures since the measured endpoint is 
lethality and rarely include evaluations of the respiratory tract. Therefore, the HECs selected for non-occupational 
bystander inhalation risk following aerial ULV mosquito adulticide applications are typically selected from a subchronic 
inhalation study. Since subchronic inhalation studies are repeat dose studies that are typically conducted for 28 or 90 days 
with daily exposures of 6 hours for 5 days per week, the use of these studies to establish the bystander inhalation POD is 
conservative. 
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the application area. This model was originally created to be used in estimating downwind deposition 
of spray drift from aerial and ground boom applications. In this case, it is used to estimate deposition 
from ULV adulticide applications by selecting parameters in the system intended to simulate such 
applications. The inputs used in AGDISPTM are either pesticide label-specific or defaults based on best 
professional assumptions or general practice (as described in the stepwise guidance provided below). 
The critical outputs from the AGDISPTM model for use in the exposure assessment of an adulticide 
pesticide application include (1) the deposition fraction, or the fraction of the application rate expected 
to deposit on the ground downwind as a result of an aerial ULV application targeting adult flying 
insects, and (2) the highest air concentration of the active ingredient at the breathing zone 
corresponds to the highest deposition following an aerial ULV application.  
 
The AGDISP™ model11 provides an estimation for off-target deposition and air concentrations that can 
be expected following an application which is the basis for estimating post-application exposures 
following aerial adulticide applications. These values are based on application parameters from the 
adulticide product label including application rate, minimum height of release, minimum wind speed, 
and droplet size needed for efficacy. Table 3.1 presents the inputs and parameters used to define the 
post-application exposure scenario within AGDISP™ as well as where the information can be found. 
The model inputs and parameters described in Section 3.1 were derived in consultation with the 
American Mosquito Control Association (AMCA) and the pesticide industry.  
 
3.1 Model Inputs and Parameters  
 

The model and inputs and parameters that are described below are based on the Agency approved 
version of AGDISP™ Version 8.26. Figure 1 provides a visual illustration of the model and example input 
parameters. Table 3.1 provides guidance for the specific parameters considered when using the 
AGDISP™ model to evaluate the potential for exposures from aerial ULV applications. Table 3.1 also 
identifies the application parameter and whether the input information needed is found on the 
adulticide product label, a generic application default value (i.e., a generic value used to represent the 
adulticide application not dependent on product label information), or a model default value (i.e., a 
default value provided within AGDISP™ that reflects the aerial application method but not specific to 
adulticide applications).  
  

 
11 Model details and availability can be found at: https://www.epa.gov/pesticide-science-and-assessing-pesticide-
risks/models-pesticide-risk-assessment 
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Figure 1. AGDISP™ Version 8.26 User Interface  
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Table 3.1. AGDISP™ Inputs (v8.26): [Chemical] ULV Adulticide Application 

Parameter Input Selection Notes/Comments1 Risk Assessment Considerations 

Application Method Aerial Model default None 

Aircraft Beechcraft KingAir C904 

Default Input. 
 
The fixed wing aircraft type must be 
manually inputted per user defined 
aircraft properties. If necessary, the 
helicopter type (Bell 206B JetRanger III) is 
selected from the model library. 

See “Beechcraft KingAir C90 Inputs” section 
3.2 below for user defined aircraft properties 
 
See “Helicopter Assessment” section 3.3 
below for whether to evaluate risks from this 
aircraft type. 

Release Height 
100 feet minimum 
release4 

This information is sometimes provided 
on the product label. 

Typically, the minimum release height ranges 
from 100 to 300 feet. If the label provides a 
minimum release height, this should be used 
for the Tier I evaluation of risk. However, if the 
label does not specify a minimum release 
height, a Tier 1 default release height of 100 
feet is used. As a Tier II evaluation, release 
heights of 200 or 300 feet can be considered 
based on the product labeling or additional 
information provided by the product 
registrant specific to the adulticide used. 
 
If the assessor would like to further refine the 
risk assessment it is suggested to contact the 
pesticide re-evaluation division (PRD) to 
confirm the registrant’s intended minimum 
release height. 

Spray Lines 20 Passes 
Spray lines varies based on drop size 
distribution (DSD) and target area. 

 

Application 
Technique 

Liquid Model default 
 

Application 
Technique: Nozzles 

2 Nozzles; Extent 60 % or 
Spacing 29.4 ft4 

Default input 
If the product label recommends more than 2 
nozzles for aerial applications, the nozzle 
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Table 3.1. AGDISP™ Inputs (v8.26): [Chemical] ULV Adulticide Application 

Parameter Input Selection Notes/Comments1 Risk Assessment Considerations 

configuration can be determined by first 
entering the number of nozzles. Then the user 
can estimate the extent or spacing (only one 
needs to be entered). For example, if 3 nozzles 
are required, the extent would = 76.3% and 
spacing = 18.7 feet. 

Application 
Technique: Drop Size 
Distribution (DSD) 

1) Select DSD 
 
2) Select User-defined 
 
3) Select Parametric 
 
4) Input label 
recommended DV0.5: X µm 
 
5) Follow directions 
provided in Section 3.4 to 
estimate the relative span 
input 
 
6) Uncheck Convert PMS 
to Malvern 
 
7) Select Drop Size 
Distribution (instead of the 
default Drop Size 
Classification) 
 
8) Select no conversion to 
Malvern Drop Size 
Distribution 

 
 
 
The Dv0.5 value is provided on the product 
label. 
 
The user must estimate the relative span 
using the directions provided in this SOP 
and the lower bound (Dv0.5) and upper 
bound (e.g., Dv0.9) droplet size range as 
provided on product labeling (see Section 
3.4). 
 
 

None 
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Table 3.1. AGDISP™ Inputs (v8.26): [Chemical] ULV Adulticide Application 

Parameter Input Selection Notes/Comments1 Risk Assessment Considerations 

Swath Width 500 feet4 Default input None 

Swath Displacement 0 feet 

The model defaults to 0 feet. However, if 
the spray deposition shows the peak 
deposition to be at a distance other than 
0 feet (i.e., the edge of the application 
area), the swath displacement should be 
changed to the horizontal distance from 
the y-axis where the peak deposition 
occurs before selecting the air 
concentration value. 
[See Section 4.1.1, Swath Displacement 
Adjustment for Peak Deposition, for an 
example in the “output” section.] 

None 

Meteorology 

Wind type: single height 
Wind direction: -90 deg 

Model default 
These inputs ensure that the wind is blowing 
perpendicular to the application spray line, 
providing a worst case estimate. 

Wind speed: 1 mph Default input 

Minimum wind speed may be found on labels 
and should be used in place of the default (1 
mph) if required. If, in consultation with 
product registrants, it is determined that 
there are a range of acceptable wind speeds, 
these wind speeds can be modeled as a Tier 2 
evaluation of risk. 

Temperature: 65 F° 
 

Default input based on typical adulticide 
environmental conditions at dusk/dawn. 

None 

Relative humidity: 50% Model default None 

Spray Material 

1) Select Material 
 
2) Enter Name as the 
product active ingredient 

 
 
 
 

None 
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Table 3.1. AGDISP™ Inputs (v8.26): [Chemical] ULV Adulticide Application 

Parameter Input Selection Notes/Comments1 Risk Assessment Considerations 

 
3) Check or uncheck Spray 
Material Evaporates based 
on whether it is oil 
(uncheck) or water (check) 
 
4) Enter the spray volume 
rate: X (gal/A) 
 
5) Enter the Active 
Fraction:  X 
Nonvol Fraction:  \ 

 
Uncheck the box for “spray material 
evaporates” if it is applied neat or mixed 
with an oil; check the box if it is mixed 
with water. 
 
The spray volume rate (gal/A); active 
fraction; non-vol value are based on the 
product label. 
 
[See Section 3.5, Spray Material, on how 
to calculate each input.] 

Atmospheric Stability Overcast Model default None 

Surface 

Upslope angle: 0 deg 
Sideslope angle: 0 deg 

Model default None 

Canopy: None Default input 

While the potential exists for obstructions 
(e.g., trees, vegetation, and houses) to be 
present during ULV aircraft applications, HED 
recommends no canopy. A “no canopy” input 
ensures that the assessment of post-
application exposures is reflective of and 
protective for applications settling on a grass 
lawn free from obstructions that may reduce 
exposure potential. 

Transport Distance: 0 feet Model default None 
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Table 3.1. AGDISP™ Inputs (v8.26): [Chemical] ULV Adulticide Application 

Parameter Input Selection Notes/Comments1 Risk Assessment Considerations 

Advanced Settings2 

1) Select Advanced 
 
2) Select Default Swath 
offset, 0 Swath 
 
3) Calculate Specific 
Gravity carrier: Oil, Water, 
or undiluted specific 
gravity value 
Specific Gravity active and 
additive = X 
 
Evaporation Rate: 84.76 

µm2/C°/sec 

Default inputs 
 
See Section 3.6, Specific Gravity, on how 
to calculate each. 

None 

1. Model default – Assumptions as recommended/programmed for use of the AGDISPTM model.  

2. Default input -  Assumptions that are recommended specific to modeling the application of ULV adulticides. Deviation from “model defaults” are justifiable as required for 

ULV adulticide applications or if there are specific instructions on the product label.  

3. Additional parameters are listed in the Advanced Settings; however, this SOP only recommends adjusting the values described under input selection if need be. The 

remaining inputs are considered default for the purposes of this assessment. 

4. Default value derived through discussions with the American Mosquito Control Association (AMCA).  
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3.2 Beechcraft KingAir C90 Inputs 
 

In consultation with the AMCA and leaders in the mosquitocide industry, HED has determined that the 
AGDISPTM model default fixed wing aircraft type, Air Tractor AT-401, is not the predominant aircraft 
model for ULV adulticide applications. The Beechcraft KingAir C90 was recommended by the AMCA 
and the mosquitocide industry as the default since the majority of these applications are now made 
with this aircraft type and the aircraft type results in more protective modeling outputs. However, the 
Beechcraft KingAir C90 is not included in the AGDISPTM library, therefore its properties must be 
inputted for modeling purposes. The aircraft properties presented in Table 3.2 should be used to 
model deposition and air concentrations following ULV adulticide applications with the Beechcraft 
KingAir C90. 
 

Table 3.2. Beechcraft KingAir C90 Aircraft Property Inputs 

Property Input 

Type User Defined 

Semispan* (ft) 25.1 

Weight (lbs) 9,000 

Typ. Speed (mph) 170 

Propeller RPM 2,000 

Prop Radius (ft) 3.9 

Biplane Sep* (ft) 0 

Planform Area* (ft2) 294 

Engines 2 

Engine Vert.* (ft) 1 

Engine Forward* (ft) 15/ 6.4 

Engine Horizontal* (ft) 0 

Wing Vert* (ft) 1.51 

Boom Vert* (ft) -1 

Boom Fwd* (ft) -0.8333 
Acronyms/Abbreviations - RPM = Revolution Per Minute, Prop = Propeller, Sep = Separation, Vert = Vertical, Fwd = Forward 
* Definitions can be found in the Glossary of this SOP. 

 
3.3 Helicopter Application Assessment 
 

Aerial applications of ULV adulticides are most commonly applied by fixed wing aircraft (i.e., airplanes) 
but depending on the product label, may also be applied with helicopters. Helicopters are commonly 
used for areas which are more difficult to treat such as barrier islands. If the product label allows for 
both fixed-wing aircraft or helicopter applications, a helicopter assessment may not always need to be 
conducted. HED has conducted sensitivity analyses to evaluate the differences in deposition and 1-
hour average air concentrations between fixed-wing aircraft and helicopters. The results of the 
sensitivity analyses indicate that fixed-wing aircraft result in the potential for higher exposures to 
adulticide applications. Therefore, if the modeling of deposition and 1-hour average air concentration 
for fixed-wing aircraft does not result in risks of concern, then the modeling results for fixed-wing 
aircrafts are protective for helicopter applications and modeling of the helicopter application is not 
required. If the fixed-wing aircraft modeling results in risks of concern, the modeling of the helicopter 
application is necessary. Table 3.3 presents the parameters used to define the helicopter scenario 
within AGDISP™. Modeling input parameters for spray lines, application technique, swath width, 
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swatch displacement, meteorology, spray material, atmospheric stability, surface, transport, and 
advanced settings are the same as those for fixed-wing aircraft. 
 

Table 3.3. AGDISP™ Inputs (v8.26): [Chemical] ULV Adulticide Application (Helicopter) 

Parameter Input Selection  Notes/Comments1 Risk Assessment Considerations 

Aircraft 

Bell 206B 
JetRanger III2 
(choose user-
defined to alter 
aircraft inputs) 

User-defined inputs: 
 
Type: Helicopter 
Rotor radius: 16.7 ft 
Weight: 2880 lbs 
Typ. Speed: 105 mph 
Rotor RPM: 384 
Boom vert: -9 ft 
Boom fwd: 0 ft 

AGDISPTM includes a default Bell 206B 
JetRanger III in the Aircraft Type library. 
The default parameters will result in lower 
deposition and 1-hour average air 
concentrations, compared to the User-
Defined inputs provided by the mosquito 
control industry. 

Release 
Height 

80 feet 
minimum 
release2 

This information is 
sometimes provided on 
the product label. 

Helicopters are capable of much lower 
release heights. The default height of 80 ft 
is typically used for treating small areas 
(barrier islands).2 Unless the label specifies 
a higher release height, the use of 80 ft will 
be a conservative assumption. 

1: All other AGDISPTM inputs for helicopter are the same as those for fixed-wing aircraft (spray lines, application technique, SW, SD, 
meteorology, spray material, atmospheric stability, surface, transport, advanced settings). 
2: Default value derived through discussions with the American Mosquito Control Association (AMCA). 

 
3.4 Droplet Size Distribution/Relative Span   
 

For adulticide control operators to maximize insecticidal efficacy, the ULV adulticide product label will 

provide details on the required droplet size distribution (i.e., the range of diameters of spray particles) 

for aerial applications. For example, a product label for Chemical X may instruct users to calibrate their 

spray nozzles and outputs such that the diameter of 50% of the spray droplets is less than 60 microns 

and the diameter of 90% of the spray droplets is less than 115 microns. This is described on the 

product labeling as DV0.5 < 60 µm and DV0.9 < 115 µm. To represent this droplet size distribution in 

AGDISP™, the relative span (a parameter representing the breadth of the drop size distribution), may 

be calculated using the equation Dv0.9-Dv0.1/Dv0.5 or by adjusting relative span in AGDISP™ until the 

required droplet size distribution is represented in the model.  

 

If the DV0.1 value is not provided on the product label, then the relative span must be determined. 

Using the Parametric Drop Size Distribution model (see Figure 2), the relative span must be adjusted to 

match label droplet distribution criteria. For the example given, the user would input the labeled DV0.5 

of 60 µm, and then repeatedly enter and adjust the relative span until the DV0.9 of the droplet size 

distribution diameter matches the labeled value, 115 µm. In the example provided in the paragraph 

above, a relative span input of 1.5 results in a droplet size distribution of DV0.5 ≈ 60 um and DV0.9 ≈ 

115 um, which matches label requirements. This will be represented in the Average Diameter and 

Cumulative Volume Fraction columns (see Figure 3). If volume median diameter (DV values) are not 

provided for the relative span calculation, the user can start with a relative span of 1.5 and adjust 

either up or down until the DV 0.9 and DV 0.5 range are within product label recommendations. 
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Figure 2. Adjustment of Relative Span to Match Label Droplet Size Distribution 

 

 
 

Figure 3. AGDISP™ Version 8.26 Drop Size Distribution Interface     

 
 

Note: To prevent the AGDISP™ model from producing an error message when runs are 
conducted (see Figure 4), check to ensure that the droplet size distribution (see Figure 3), 
contains values only within the model’s allowable range. In order for the model to run the 
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calculations, the smallest DSD must have a minimum value of 1.00 and a maximum value of 
10,000. To alleviate the error prior to running the model, right click and delete any row(s) in 
the drop distribution menu < 1.00 and > 10,000. This correction should then allow the model 
to run without error. 

 

Figure 4. AGDISP™ Version 8.26 Drop Size Distribution Error Correction 

 
 

3.5. Spray Material 
 

The spray material inputs for AGDISP™ are specific to the adulticide product under consideration. The 
Spray Volume and Active and Nonvol Fractions are determined and calculated based on whether the 
product is diluted or undiluted prior to application and based on the product label instructions for 
number of gallons of spray to be applied over an acre. Figure 5 provides a visual illustration of the 
Spray Material parameters screen within AGDISP™ and example input parameters as derived from the 
product application rate and calculated using the methods described in Table 3.1. Tables 3.5.1 and 
3.5.2 provide examples of these calculations. The Spray Volume Rate and Nonvol Fractions can also be 
determined with use of these same calculations. 
 
For Figure 5, the example adulticide product is assumed to be applied neat (applied undiluted) and 

does not evaporate. Typically, ULV adulticide products are formulated in a manner which inhibits spray 

material evaporation and increases the stability of active ingredient. Ideally, the applied droplets are 

small enough to remain aloft but do not evaporate such that they reduce in size and inhibit the ability 

of the droplet to impact targeted flying insects. Therefore, if the product is oil-based, it is 

recommended that the “Spray Material Evaporates” box be unchecked. However, not all adulticide 

products are oil-based; some adulticide products are water-based and will evaporate. In the case that 

an adulticide is water-based, the “Spray Material Evaporates” box should be checked before running 

the model.  
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Figure 5. AGDISP™ Version 8.26 Spray Material User Interface  

 

 
Table 3.5.1. AGDISP™ Inputs (v8.26): Spray Material Inputs and Calculations 

% ai1 Determined by the product label 

lbs ai/ gallon product1 Determined by the product label 

lb ai/acre1  Application rate determined by the product label 

Diluted or undiluted1 Determined by the product label 

Dilution Factor1 Determined by the product label (1:x) 

= (1 𝑝𝑎𝑟𝑡 𝑝𝑟𝑜𝑑𝑢𝑐𝑡
+ 𝑋 𝑝𝑎𝑟𝑡𝑠 𝑤𝑎𝑡𝑒𝑟 𝑜𝑟 𝑜𝑖𝑙) 

 
(i.e., 1:1 dilution = 2 dilution 

factor) 

Spray volume (gal finished 
spray/A)2 

Calculated based on the application 
rate (lbs ai/acre) and lbs ai/gallon of 

product, adjusted by the dilution factor 

=
(
𝑙𝑏𝑠 𝑎𝑖
𝑎𝑐𝑟𝑒

)

(
𝑙𝑏𝑠 𝑎𝑖

𝑔𝑎𝑙𝑙𝑜𝑛 𝑝𝑟𝑜𝑑𝑢𝑐𝑡
)

× 𝑑𝑖𝑙𝑢𝑡𝑖𝑜𝑛 𝑓𝑎𝑐𝑡𝑜𝑟 

Nonvol Fraction2 
Determined based on the dilution 

fraction 
=

1

𝐷𝑖𝑙𝑢𝑡𝑖𝑜𝑛 𝑓𝑎𝑐𝑡𝑜𝑟
 

Active Fraction2 
Calculated based on the %ai and 

nonvol fraction 
= (

%𝑎𝑖

100
) × 𝑛𝑜𝑛𝑣𝑜𝑙 𝑓𝑟𝑎𝑐𝑡𝑖𝑜𝑛 

1. These values and label information help with calculating the inputs for the spray material parameters. 

2. These calculations are direct inputs for the information used to complete the spray material parameters (See 

Figure 3.1 above). 
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Table 3.5.2. AGDISP™ Inputs (v8.26): Example Spray Material Inputs and Calculations 

% ai 20 20 20 20 

lbs ai/ gallon 
product 

1.48 1.48 1.48 1.48 

lb ai/acre 
(application rate) 

0.0070 0.0070 0.0070 0.0070 

Diluted or 
undiluted 

undiluted diluted 1:1 diluted 1:2 diluted 1:4.5 

Spray volume (gal 
finished spray/A) 

=
0.0070

1.48
 × 1 

 
= 0.0047 

=
0.0070

1.48
 × 2 

 
= 0.0095 

=
0.0070

1.48
 × 3 

 
= 0.014 

=
0.0070

1.48
 × 5.5 

 
= 0.026 

Nonvol Fraction1 1 =
1

1
 0.5 =

1

2
 0.33 =

1

3
 0.18 =

1

5.5
 

Active Fraction 
= (

20

100
) × 1 

 
= 0.20 

= (
20

100
) × 0.5 

 
= 0.1 

= (
20

100
) × 0.33 

 
= 0.067 

= (
20

100
) × 0.18 

 
= 0.036 

1. The model will not allow a Nonvol Fraction of “1”. If the user receives an error, replace “1” with “0.99” 

 

3.6 Specific Gravity  
 

The Specific Gravity input for the product is located under the Advanced Settings segment of the 
AGDISP™ model. Specific gravity of a substance is the ratio of the density of the substance to the 
density of water. The “Specific Gravity (Carrier)” input reflects the specific gravity of the solvent or 
diluent. In most cases for ULV adulticides, this is an oil-based formulation. In the case of an application 
spray being undiluted, the specific gravity is reflective of the specific gravity of the product (Active and 
Additive). The specific gravity can be located on the chemical product’s confidential statement of 
formulation (CSF) found in the Office of Pesticide Programs Information Network (OPPIN) or by 
searching online for the product’s most recent safety data sheet (SDS) using the product name and/or 
EPA Registration Number. The specific gravity is typically located in the physical and chemical 
properties section of the SDS. If specific gravity is not provided in the SDS or cannot be located in 
OPPIN, the user can determine this using specific gravity calculations below.  
 
“Specific Gravity (Active and Additive)” is calculated based on the density of the product (lbs ai/ gallons 
of product) divided by the active fraction of the product (%ai/100) then further divided by the density 
of water (8.34 lb/gal). [Note: Although the example above in Table 3.5.2 shows that the active fraction 
changes as the product is further diluted for spray application, the “Specific Gravity (Active and 
Additive)” is based solely on the undiluted product].  
 

Table 3.6. AGDISP™ Inputs (v8.26): Specific Gravity Calculations 

Specific Gravity (Carrier = Water) 1 

Specific Gravity (Carrier = Oil) 0.8 

Specific Gravity (No Carrier/Undiluted)  
and/or 
Specific Gravity (Active and Additive) 

= (
𝑙𝑏𝑠 𝑎𝑖

𝑔𝑎𝑙𝑙𝑜𝑛 𝑜𝑓 𝑝𝑟𝑜𝑑𝑢𝑐𝑡
) ÷ (%𝑎𝑖) ÷ (8.34 𝑙𝑏/𝑔𝑎𝑙) 
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Table 3.6. AGDISP™ Inputs (v8.26): Specific Gravity Calculations 

Using the example in Table 3.5.2 above for Chemical X with a water carrier the equation would look as 
follows: 

0.89= (
1.48 𝑙𝑏𝑠 𝑎𝑖

𝑔𝑎𝑙𝑙𝑜𝑛 𝑜𝑓 𝑝𝑟𝑜𝑑𝑢𝑐𝑡
) ÷ (0.2) ÷ (8.34 𝑙𝑏/𝑔𝑎𝑙) 

 

4.0 Aerial ULV Post-Application Exposure Assessment: Running the AGDISP™ Model   
 

4.1 Modeling Peak Deposition 
 

Once all the inputs for AGDISPTM have been determined or calculated, and inserted, the model can be 
run. 

• Select File then Save the model run 

• Select “Run”→ “Run Calculations” 

Note:  When the AGDISPTM model is preparing to run the calculations, it often indicates the 
inputs or parameters defined by the user are outside of the range or capability of the model. 
This is normal and the user should, after reviewing the warnings, accept them, even if there 
are multiple, to allow the modeling to proceed.  

 
Once an AGDISPTM model run has been completed, the deposition fraction and air concentration can 
be determined from the outputs. The user should then determine whether the peak deposition is 
occurring at the edge of the residential application area (i.e., 0 feet) or at some other distance. It is 
necessary to model deposition such that the peak occurs at the 0 ft distance so that the model will 
provide a complementary 1-hour average air concentration output representative of the maximum for 
the product and aerial application aircraft and inputs modeled (see 4.1.1 Swath Displacement 
Adjustment for Peak Deposition). The following provides directions for viewing graphical 
representations of deposition output from the AGDISPTM model.  
 

• Select “View”→ “Application Layout” to see a graphical representation of the deposition 

pattern 

If the peak “Deposition” on the Y-axis occurs at the 0 ft distance on the X-axis, no adjustments need to 

be made to the above inputs (see Figures 6 and 7). If the graph does not show the peak “Deposition” 

value occurring at the 0 ft distance on the horizontal X- axis, see Section 4.1.1, Swath Displacement 

Adjustment for Peak Deposition. 
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Figure 6. AGDISP™ Version 8.26 Graphical Representation: Application Layout 

 
 

• Select “View”→ “Deposition” to see a graphical representation of the peak deposition fraction. 

 

Figure 7. AGDISP™ Version 8.26 Graphical Representation: Deposition 

 

Modeled deposition outputs at different distances can be evaluated in AGDISPTM by viewing the 

“Application Layout” model export using the following steps:  

• For numerical outputs, select “File”→ “Export”→ and check “Application Layout”→ “OK” 

• Deposition values are on the right column in the exported .txt file. Peak deposition will be the 

highest value (shown in bold).  

Distance (ft) 
X axis 

Deposition  
(unitless fraction) 

Y axis 

0 0.746852 

6.5616 0.7451532 

13.1232 0.7356942 
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19.6848 0.7177281 

26.2464 0.6959437 

32.808 0.6761076 

39.3696 0.6607766 

45.9312 0.6495197 
1. The model may output a deposition value greater than 100%. This can occur as applied residues drift and 

incrementally deposit following multiple fixed-wing aircraft passes within the treatment area. 

In the example of the table above, peak deposition of 0.746852 (i.e., 75% of the application rate) 

occurs at 0 feet.  

 

4.1.1 Swath Displacement Adjustment for Peak Deposition  
 

The swath displacement input is critical in estimation of both peak deposition and 1-hour average air 
concentration. If the “Application Layout” graphical view does not show peak deposition occurring at 
the 0 ft distance mark (see Figure 8, below), it is necessary that the user adjust the “Swath 
Displacement” input in AGDISP™ to ensure that the maximum air concentration is identified. The 
example below shows the deposition fraction of 0.746852 occuring at distances other than “0 ft.”  
Because of this, the distance (X-axis) for the highest deposition fraction must be inputted into the 
swath displacement. After adjusting the swath displacement and then re-running and re-saving the 
model run, the peak deposition of 0.746852 will be graphically represented at 0 ft. The user can then 
rely on the 1-hour average air concentration value to be used for risk assessment. 
 
The following example illustrates how to adjust swath displacement so that the peak deposition occurs 

at the 0 ft distance mark. In Figure 8., the application layout’s graphical representation is not depicting 

peak deposition occurring at 0 ft. Because of this, the swatch displacement input must be adjusted. It is 

important to note that peak deposition can occur at more than one distance (ft) on the X-axis, as 

shown in Figure 8. The user can choose either distance from the highest deposition fraction for 

adjusting swatch displacement (i.e., -249.3408 ft or 249.3408 ft), and the resulting 1-hour average air 

concentration values will be identical. Use the following directions to correctly determine the value for 

swath displacement: 
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Figure 8. AGDISP™ Version 8.26 Application Layout Graphical Representation: Before Adjusting 

for Swath Displacement 

 

1. For numerical outputs, select “File”→ “Export”→ and check “Application Layout”→ “OK” 

2. Scroll until the highest (peak) deposition in the right column (shown below) is identified. The 

user may have to scroll down in the output text file to find the peak deposition value. 

3. Select the distance associated with the peak deposition and input this distance value (left 

column) into the swath displacement input window in AGDISPTM. Note: This distance may be 

represented as either a positive or negative number. The user should select the distance 

value corresponding to the highest deposition, whether it be a positive or negative value. 

However, if the values are equivalent in either direction, it is recommended to use the 

positive value for simplicity.  

4. Once the peak deposition value can be seen occurring at or close to 0 ft, the user can rely on 

that run for both the deposition fraction and the air concentration. 

Distance (ft) 
X axis 

Deposition 
Y axis 

229.656 0.740643 

236.2176 0.7429743 

242.7792 0.745122 

249.3408 0.746852 

255.9024 0.7451532 

262.464 0.7356942 

269.0256 0.7177281 

275.5872 0.6959437 

282.1488 0.6761076 
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In this example output above, the peak deposition (0.747852) occurs at approximately 
249.3 ft. For the peak deposition mark to occur at 0 ft, the “Swath Displacement” value 
should be adjusted from 0 to an input of 249.3 (add 249.3 into the input box for “Swath 
Displacement” in AGDISPTM). After re-running and re-saving the model run, the peak 
deposition of 0.746852 will be graphically represented at 0 ft.  
 
Once the peak deposition value occurs at or close to 0 ft, the user can rely on that run for 

estimates of both the deposition fraction and the 1-hour average air concentration. Figure 9 

presents the graphical representation of the application layout output results after 

adjusting the swath width to achieve peak deposition at 0 ft.  

Distance (ft) 
X axis 

Deposition  
Y axis 

0 0.746852 

6.5616 0.7451532 

13.1232 0.7356942 

19.6848 0.7177281 

26.2464 0.6959437 

32.808 0.6761076 

39.3696 0.6607766 

45.9312 0.6495197 
 

Figure 9. AGDISP™ Version 8.26 Application Layout Graphical Representation: After Adjusting for 

Swath Displacement  
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4.1.2 Post-Application Dermal and Non-Dietary Ingestion Exposure Assessment 
 

Post-application exposures are expected to occur from activities on turf following aerial ULV adulticide 
applications in residential areas. Dermal and non-dietary ingestion (hand-to-mouth) exposure 
pathways are expected to result from contact with residues deposited on turf. 
 
Once the highest estimated deposition fraction from AGDISPTM is determined, it is used in conjunction 
with the standard methods used for estimating potential dermal and hand-to-mouth doses among 
adults and children 1 to <2 years old as described in the 2012 Residential SOPs: Treated Turf SOP and 
presented below.12Indirect deposition on the ground/turf can occur following an aerial ULV adulticide 
application targeting adult flying insects. The deposition output (Dep) is used to determine what 
fraction of the total aerial ULV adulticide application rate is expected to deposit and be available on 
turf for transfer to the exposed individual. This value does not represent the fraction of residues which 
may transfer from the turf to the treated individual. This value, F, the fraction of deposited residue that 
is transferable residue following application, is the same as is recommended as an SOP default for 
liquid formulations, 0.01 (1%). If chemical-specific TTR data are available, these should be considered 
for usage in place of the default SOP “F” value.  
 
The following presents the standard methods used to estimate dermal and hand-to-mouth doses 
following aerial ULV applications:  
 
Post-application Dermal Exposure Algorithm – Physical Activities on Turf 
Exposure resulting from contacting previously treated turf while performing physical activities is 
calculated as shown below. Residential post-application exposure assessment must include calculation 
of exposure on the day of application. Therefore, though an assessment can present exposures for any 
day “t” following the application, it must include “day 0” exposure. 
 

E = TTRt * CF1 * TC * ET 
 
where: 
 
E = exposure (mg/day); 
TTRt = turf transferable residue on day t (μg/cm2); 
CF1 = weight unit conversion factor (0.001 mg/μg); 
TC = transfer coefficient (cm2/hr); and 
ET = exposure time (hr/day). 
 
If chemical-specific TTR data are available, then surface residues from the day of application should be 
used (assume that individuals could be exposed to residues immediately after application). However, if 
data are not available, then TTRt can be calculated using the following formula: 
 

TTRt= (AR * F * (1-FD)t * CF2 * CF3) * Dep 
 

 
12 Available: http://www.epa.gov/pesticide-science-and-assessing-pesticide-risks/standard-operating-procedures-
residential-pesticide 
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where: 
 
TTRt = turf transferable residue on day t (μg/cm2); 
AR = application rate (lbs ai/ft2 or lb ai/acre); 
F = fraction of ai as transferable residue following application (unitless); 
FD = fraction of residue that dissipates daily (unitless); 
t = post-application day on which exposure is being assessed; 
CF2 = weight unit conversion factor (4.54 x 108 μg/lb);  
CF3 = area unit conversion factor (1.08 x 10-3 ft2/ cm2 or 2.47 x 10-8 acre/cm2); 
Dep = deposition fraction (unitless). 
 
Dermal absorbed doses are calculated as: 
 

 
BW

AFE
D

*
=    

 
where: 

D = dose (mg/kg-day); 
E = exposure (mg/day); 
AF = absorption factor (dermal); and 
BW = body weight (kg). 

 
Table 4.1.2.1: Turf (Physical Activities) -- Inputs for Residential Post-application Dermal Exposure Following Aerial 
ULV Adulticide Applications 

Algorithm Notation 
Exposure Factor 

(units) 
Point Estimate(s) 

AR 
Application rate 

(mass active ingredient per unit area) 
[input] 

Dep 
AGDISPTM Modeled Deposition Fraction (fraction of active 

ingredient applied deposited on residential turf) 
X 

F 
Fraction of AR (liquid formulation) as TTR following 
application (if chemical-specific data is unavailable) 

0.01 

FD 
Daily residue dissipation (if chemical-specific data is 

unavailable) 
(fraction) 

0.1 

TC 
Transfer Coefficient (Liquid 

Residue) (cm2/hr) 

Adults 180,000 

Children 1 < 2 years old 49,000 

ET 
Exposure Time 
(hours per day) 

Adults 1.5 

Children 1 < 2 years old 1.5 

BW 
Body Weight 

(kg) 

Adults 80 

Children 1 < 2 years old 11 

L/WP/WDG = Liquids/Wettable Powders/Water-dispersible Granules 

 
Post-application Hand-to-Mouth Exposure Algorithm– Physical Activities on Turf 
Exposure from hand-to-mouth activity is calculated as follows (based on the algorithm utilized in the 
SHEDS-Multimedia model): 
 

E = [HR * (FM * SAH) * (ET * N_Replen) * (1- (1- SE)(Freq_HtM/N-Replen))] 
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where: 
 
E = exposure (mg/day); 
HR = hand residue loading (mg/cm2); 
FM = fraction hand surface area mouthed / event (fraction/event); 
SAH = typical surface area of one hand (cm2); 
ET = exposure time (hr/day); 
N_Replen = number of replenishment intervals per hour (intervals/hour); 
SE = saliva extraction factor (i.e., mouthing removal efficiency); and 
Freq_HtM = number of hand-to-mouth contacts events per hour (events/hour). 
 
and 
 

 
2 * SA

DE * Fai
  HR

H

hands=   

 
where: 
 
HR = hand residue loading (mg/cm2); 
Faihands  = fraction ai on hands compared to total surface residue from dermal transfer coefficient study 
(unitless); 
DE = dermal exposure (mg); and 
SAH = typical surface area of one hand (cm2). 
 
Dose, normalized to body weight, is calculated as: 
 

 
BW

E
D =    

 
where: 

D = dose (mg/kg-day); 
E = exposure (mg/day); and 
BW = body weight (kg). 
 

Table 4.1.2.2: Turf (Physical Activities) – Inputs for Residential Post-application Hand-to-Mouth Exposure Following 
Aerial ULV Adulticide Applications 

Algorithm 
Notation 

Exposure Factor 
(units) 

Point Estimate(s) 

Faihands 
Fraction of ai on hands from dermal transfer coefficient 

study 
(unitless) 

0.06 

DE Dermal exposure (mg) Calculated 

SAH 
Typical surface area of one hand (cm2), children 1 < 2 

years old 
150 
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Table 4.1.2.2: Turf (Physical Activities) – Inputs for Residential Post-application Hand-to-Mouth Exposure Following 
Aerial ULV Adulticide Applications 

Algorithm 
Notation 

Exposure Factor 
(units) 

Point Estimate(s) 

HR Residue available on the hands (mg/cm2) Calculated via (DE * Faihands)/SAH 

FM 
Fraction hand surface area mouthed 

(fraction/event) 
0.127 

N_Replen 
Replenishment intervals per hour 

(intervals/hr) 
4 

ET 
Exposure time  

(hrs/day) 
1.5 

SE 
Saliva extraction factor 

(unitless) 
0.48 

Freq_HtM 
Hand-to-mouth events per hour 

(events/hr) 
13.9 

BW 
Body Weight 

(kg) 
Children 1 < 2 years old 11 

 
All algorithm inputs referenced in Tables 4.1.2.1 and 4.1.2.2 are defined in the 2012 SOPs: Treated Turf 
SOP (Section 3.2) except for the aerial ULV residue deposition fraction (Dep) input as estimated using 
AGDISPTM.  
 
4.2 Determining 1-Hour Average Air Concentration 
 

Once the highest estimated deposition fraction from AGDISPTM is determined, the 1-hour average air 
concentration can be viewed. This output allows for estimating potential inhalation exposures to both 
adults and children following ULV adulticide applications. The following step is used to view a graphical 
representation of the estimated 1-hour average air concentration. Figure 10 presents the graphical 
representation of 1-hour average air concentration from AGDISPTM modeling.  
 

• Select “View”→ “1-Hour Average Concentration” to see a graphical representation of the air 
concentration.  
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Figure 10. AGDISP™ Version 8.26 Graphical Representation: 1-Hour Average Air Concentration 

 

 

In the example shown in Figure 10, the 1-hour average air concentration can be seen to fluctuate 
as residues settle to the ground. The 1-hour average air concentrations of concern for risk 
quantitation range from 3 to 6 feet. These concentrations can be difficult to estimate with use of 
the graphical output alone and can be viewed as an exported “.txt” file for determination of the 
modeled air concentration values. The following should be used to view the 1-hour average 
concentration export file.  

 

• For numerical outputs, select “File”→ “Export”→ and check “1-hour Average Concentration”→ 

“OK” 

• Save exported file to view 

 

For the assessment of inhalation risks following aerial ULV adulticide applications, adult breathing 

height is considered 6 feet and child breathing height is 3 feet (see adult and child breathing heights 
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and corresponding concentrations as shown in the image above). Select the air concentration, which is 

the closest to either the 3-, or 6-foot height for child and adult breathing height, respectively. Keep in 

mind the air concentration values calculated within AGDISP™ are provided in units, ng/L, and, 

therefore, the output units must be converted. 

 

4.2.1 Use the Estimated 1-Hour Average Air Concentration to Quantify Inhalation Risks 
 

Non-occupational bystander inhalation risks can be estimated with use of the modeled adult and child 
1-hour average air concentrations and the human equivalent concentrations (HECs) estimated by the 
toxicologist specific to the exposure scenario being assessed. The anticipated time spent outdoors on 
turf by adults and children is 1.5 hours on the day of application only (Section 3; Treated Turf SOP) – 
there is no expectation that bystanders will be repeatedly exposed to airborne concentrations of 
adulticides over a period of many days or weeks. Ideally, the HEC should be calculated in a manner 
such that the anticipated acute bystander inhalation exposure duration would match the duration of 
the study used as the basis for the toxicological endpoint. Since appropriate acute toxicological 
inhalation data are rarely available and/or subchronic inhalation studies may not be available, it may 
be necessary to use an oral point of departure, which may require additional conversion of modeled air 
concentrations for comparison to oral points of departure. The risk assessor should work with their 
toxicologist to determine appropriate endpoints based on the toxicological profile of the active 
ingredient.  
 
Quantification of post-application inhalation margins of exposure (MOEs) following aerial ULV 
adulticide applications is conducted by use of the following formula:  
 
MOE = Human Equivalent Concentration (mg/m3)/ AGDISP™  1-Hour Average Concentration (mg/m3) 
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5.0 Glossary 
 

Active Rate: The mass of the active ingredient applied over a given area mixed into a finished spray. 
 
Aircraft type: In AGDISPTM, one of two aircraft types may be selected: either fixed-wing aircraft or 
helicopter. Both models contain databases generated by the Spray Drift Task Force and the Foresty 
Service containing properties for a number of different aircraft used in pesticide applications. 
 
Biplane Separation: Vertical distance separating two wings in a biplane. 
 
Boom Forward: horizontal distance ahead of the trailing edge of the wing to the spray boom, 
measured positive forward from the wing and thus typically a negative number. 
 
Boom Vertical: vertical distance above the trailing edge of the wing to the spray boom, measured 
positive upward from the wing and thus typically a negative number. 
 
Canopy: A description of the canopy, available in regular mode in AGDISPTM. Inputs include Canopy 
Name, Canopy Type (None, Basic, Story, and Optical), Canopy Properties, Properties, and Preview. 
Under Canopy Type, None removes the canopy type. Basic type enters only Canopy Height. For Story 
and Optical canopy types the user enters the Canopy Element Size, Temperature, and Relative 
Humidity. For Story type the user enters Stand Density and describes the canopy by Tree Height (in 
feet or meters), Tree Diameter (in feet or meters), and Probability of Penetration (0 to 1). For Optical 
type the user may select from an Optical Tree Library, then modify Tree Height and LAI, or describe the 
canopy by Tree Height (in feet or meters) and Cumulative LAI. 
 
Carrier type: The material used to dilute a formulated product to a finished spray material.  
 
Drop size distribution: The range of diameters of spray particles, as defined by the American Society of 
Agricultural Engineers (ASAE), which can be altered through variable nozzles and spray pressure. The 
ASAE recently changed its name to American Society of Agricultural and Biological Engineers (ASABE).  
Dv0.5: The drop diameter (in microns) at which 50 percent of the spray volume is in drops smaller than 
this value, and 50 percent is in drops larger than this value.  
 
Engine Forward: horizontal location of the aircraft engine propeller relative to the trailing edge of the 
wing, measured positive forward and thus typically a positive distance. 
 
Engine Horizontal: horizontal location of the aircraft engine centerline, relative to the centerline of the 
aircraft, measured positive to the right of the pilot and thus zero or a positive distance. 
 
Engine Vertical: vertical location of the aircraft engine centerline relative to the trailing edge of the 
wing, measured positive upward. 
 
Fraction of Applied: The amount of deposition divided by the application rate.  
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Malvern: A type of laser diffraction particle size analyzer used to measure droplet distributions. It was 
used by the Spray Drift Task Force to measure the drop size distributions used in their trials. The 
system uses spatial, or number-density weighted, sampling. 
 
Nonvolatile rate: The volume (AGDISPTM) of formulated product applied over a given area. 
 
Number of flight lines: The effective upwind dimension (or width) of the spray area is computed by 
multiplying the Number of Flight Lines by the Swath Width of the aircraft. 
 
Planform Area: The surface area of the wing calculated from a top down view. 
 
Relative humidity: Ratio of the actual vapor pressure of the air to the saturation vapor pressure (in 
percent). Its value is normally between 5 and 100 percent.  
 
Relative Span: A parameter representing the breadth of the drop size distribution, (Dv0.9-Dv0.1/Dv0.5). 

 
Release height: Height of release of pesticide product (similar to boom height). 
 
Semispan: Half of the calculated wingspan. 
 
Specific gravity: Density (i.e. the ratio) of the mass of a material to the mass of an equal volume of 
water at a specific temperature, such as 20 °C. Thus, the specific gravity of water is 1.0, while the 
specific gravity of oil is 0.8. Its value for carriers and nonvolatiles is normally between 0.78 and 1.35. 
 
Spray block: The designated area being treated via aerial application, also referred to as treatment 
block. 
 
Spray volume rate: The volume of finished spray applied over a given area.  
 
Swath width: The width of field that receives pesticide application from a single pass of a spray boom. 
For agricultural crops, this is typically a factor of the aircraft type, the span of the nozzles along the 
wing, the droplet size, and the height of release. This along with the number of flight lines and the 
length of the spray line determines how big of an area is treated. For agricultural crops this is typically 
40-75 ft. For adulticide applications, this is typically 500-1500 ft. Part of this is because the height of 
release for agricultural crops is about 10 ft above the crop, while adulticide applications are usually 75-
300 ft above the ground. 
 
Swath displacement: The horizontal distance along the ground from the farthest downwind flight line 
to the edge of the application area, used to make sure the application does not extend beyond the 
edge of the field. 
 
Swath offset: The distance a pilot offsets application from the downwind edge of the application area 
to account for the wind speed. 
 
Temperature: The ambient temperature (in degrees Fahrenheit or degrees Centigrade).  
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Wind Direction: The direction from which the wind is blowing, measured relative to the flight direction 
of the aircraft. The default model value is -90 deg, implying the wind is blowing perpendicular to the 
direction of flight.  
 
Wind Speed: The wind speed (in miles per hour or meters per second) 2 meters off the ground. Its 
value is normally between 1 and 20 mph. Most adulticide applications are limited to wind speeds of 1 
to 10 mph. 
 
Wing Vertical: the vertical distance between the wing tip and the wing root at the centerline of the 
aircraft, positive upward. 
 


